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1 Introduction
1.1 How to Use this Manual
The layout of this manual is designed to provide quick reference to the sections of interest
to the reader. However, in order to obtain a full understanding of the interface, Thermo
Fisher Scientific recommends that you review the manual thoroughly before beginning
operation.
Almost all descriptions in the manual apply to all types of the Universal Chromatography
Interface. Therefore, the term "the UCI" or "the device" is used throughout the manual. If
some detail applies to only one type, the type is identified by name.
Note:

The device configuration may vary; therefore, not all descriptions necessarily
apply to your particular instrument.
The software descriptions in this manual refer to firmware version 3.03 and
Chromeleon™ 6.80 Service Release 13.

This manual is provided "as is." Every effort has been made to supply complete and
accurate information and all technical specifications have been developed with the utmost
care. The information contained in this manual should not be construed as a commitment
by Thermo Fisher Scientific. Thermo Fisher Scientific assumes no responsibility for any
errors that may appear in this document. This document is believed to be complete and
accurate at the time of publication. In no event shall Thermo Fisher Scientific be liable for
incidental or consequential damages in connection with or arising from the use of this
document.
The information contained in this document is subject to change without notice.
All rights reserved, including those for photomechanical reproduction and storage on
electronic media. No part of this publication may be copied or distributed, transmitted,
transcribed, stored in a retrieval system, or transmitted into any human or computer language,
in any form or by any means, electronic, mechanical, magnetic, manual, or otherwise, or
disclosed to third parties without the express written permission of Thermo Fisher Scientific
Inc.
Trademarks
Windows and Windows Vista are registered trademarks of Microsoft Corp.
All other trademarks are property of Thermo Fisher Scientific Inc. and its subsidiaries.
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1.2 Safety Information
The CE Mark label on the bottom of the UCI indicates that the module is compliant with
the related standards.
1.2.1 Symbols on the Module and in the Manual
The table shows the symbols used on the instrument:
Symbol

Description
Refer to the Operating Instructions to prevent risk of harm to the operator and to
protect the module against damage.
Référez-vous à ce manuel pour éviter tout risque de blessure à l'opérateur et/ou
protéger le module contre tout dommage.
Label according to the "Measures for Administration of the Pollution Control of
Electronic Information Products" (China RoHS) guideline
Étiquette "Measures for Administration of the Pollution Control of Electronic
Information Products" (China RoHS)
WEEE (Waste Electrical and Electronic Equipment) label—For more
information, see the WEEE Information section in the "Installation and
Qualification Documents for Chromatography Instruments" binder. Étiquette
WEEE (Waste Electrical and Electronic Equipment) —Pour plus d'informations,
référez-vous au chapitre WEEE Information dans le classeur "Installation and
Qualification Documents for Chromatography Instruments".

At various points throughout the manual, messages of particular importance are indicated
by certain symbols:
Tip:

Indicates general information, as well as information intended to
optimize the performance of the instrument.

Important:

Indicates that failure to take note of the accompanying information
could cause wrong results or may result in damage to the module.

Important:

Indique que ne pas tenir compte de l'information jointe peut conduire
à de faux résultat ou endommager l'instrument.

Warning:

Indicates that failure to take note of the accompanying information
may result in personal injury.

Avertissement: Indique que ne pas tenir compte de l'information jointe peut entraîner
des blessures corporelles.
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1.2.2 General Safety Precautions
Before initial operation of the UCI, make sure that you are familiar with the contents of
this manual.
Warning:

All users of the device must observe the following safety precautions
and all additional safety precautions in this manual to avoid the
possibility of personal injury when operating the device.

•

Replace faulty communication cables.

•

Replace faulty power cords. Never use a power cord other than the power cords provided
for the device.

•

Use only the original spare parts and accessories authorized for the device by Thermo
Fisher Scientific.

•

Do not use the UCI in ways other than those described in these operating instructions.

•

Keep the operating instructions near the device to be available for quick reference.

1.2.3 Consignes Générales de Sécurité
Avant de commencer à utiliser l'instrument, assurez-vous que vous vous êtes familiarisés
avec le contenu de ce manuel. Observez les étiquettes d'avertissement sur l'appareil et
référez-vous aux sections correspondantes dans ce mode d'emploi.
Avertissement: Toutes les personnes utilisant l’instrument doivent observer les
consignes de sécurité suivantes et dans les autres chapitres de ce
manuel pour éviter une mise en danger de sa personne pendant
l’utilisation.
•

Remplacez les câbles de communication défectueux.

•

Remplacez les cordons d'alimentation électrique défectueux. Utilisez uniquement les
cordons d’alimentation électrique spécifique à l’instrument.

•

Utilisez seulement des pièces de rechange originales et des accessoires autorisés par
Thermo Fisher Scientific.

•

N'utilisez pas l'instrument de manière autre que celles décrites dans ce manuel.

•

Conservez ce manuel á proximité de l’instrument pour pouvoir le consulter facilement.
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1.3 Intended Use
For Research Use Only. Not for use in diagnostic procedures.
The device is designed to be operated only be qualified and authorized personnel. All users
must know the hazards presented by the device and the used substances.
The UCI is designed to be an interface between the Chromeleon Chromatography
Management System and the modules of a chromatographic system.
Please note that the UCI may be operated only by using the accessories and spare parts
authorized by Thermo Fisher Scientific (→ page 49) and within its technical specifications
(→ page 47).
If there is any question regarding appropriate usage, contact Thermo Fisher Scientific before
proceeding.
Thermo Fisher Scientific cannot be held liable for any damage, material or otherwise,
resulting from inappropriate or improper use of the instrument.
Warning:

If the device is used in a manner not specified by Thermo Fisher
Scientific, the protection provided by the device could be impaired.
Thermo Fisher Scientific assumes no responsibility and will not be
liable for operator injury and/or instrument damage. Whenever it is
likely that the protection is impaired, the instrument must be
disconnected from all power sources and be secured against any
intended operation.

Avertissement: Si l'instrument est utilisé de façon non spécifiée par Thermo Fisher
Scientific, la protection prévue par l'instrument pourrait être altérée.
Thermo Fisher Scientific n'assume aucune responsabilité et ne sera
pas responsable des blessures de l'operateur et/ou des dommages de
l'instrument. Si la protection de l'instrument n'est pas garanti à tout
moment, débranchez l'instrument de toutes les sources d'alimentation
électrique et assurez-vous que l'instrument n'est pas utilisé
involontairement.

1.4 Federal Communications Commission (FCC) Note
This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the U.S. FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference, in which case the user will be required to
correct the interference at his expense.
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2 Overview
2.1 Unit Description
In chromatographic systems, the most different interface types are required for data
acquisition and device control. The UCI provides these different interfaces and makes
them available to the chromatography server. In this way, virtually any chromatography
device can be used with Chromeleon.
•

Chromatographic detectors convert signals, for example, absorption or conductivity, into
electric voltage. However, as a computer can process only digital information, electric
voltage must be converted into digital data. If the detector itself is not capable of
performing this conversion, an analog/digital converter is required.
The autoranging A/D with 25-bit dynamic resolution of the UCI provides accurate,
reliable measurement of large and small peaks in the same chromatographic run.

•

The fast data collection rate (100 Hz) and high channel stability ensure faithful
representation of narrow peaks, such as those typical with gas chromatography (GC) and
capillary electrophoresis.

•

The front panel LEDs visualize the detector signal levels that are currently applied to the
analog inputs (voltage levels), the TTL and relay states, and the activity of the computer
communication ports.

•

Four independent RS-232 interfaces allow simultaneous control of up to four
chromatography modules.

•

The (16-bit) BCD inputs of the UCI allow BCD-enabled autosamplers to communicate to
Chromeleon the position of the vial from which the injection was performed.

•

Eight potential-free relay outputs and eight TTL inputs support communication with all
kinds of chromatography devices.

•

Data transmission between the UCI and Chromeleon is by using either the integrated
USB (Universal Serial Bus) interface or the LAN interface (Ethernet).

•

Self-test and automatic online calibration make adjustments and maintenance
unnecessary.

2.2 UCI Configurations
The UCI is available in the following configurations:
UCI

Description

Part No.

UCI-100

Universal Chromatography Interface, 8 channels

5911.0010

UCI-50

Universal Chromatography Interface, 2 channels

5911.0005

Operating Instructions
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2.3 Front Panel Elements

1
2
3

4

5

6

Fig. 1: Front panel view (here UCI-100)
No.

LED

Description

1

USB

The LED flashes if data is transmitted over the USB connection.

2

LAN

The LED is on if a LAN connection is established ('good link').

3

Power

The LED is on if the UCI is connected to the power supply by using
the power supply unit.

4

RS232 Ports

The 'Transmit' LED of an RS-232 port is on (red) if data is sent
through this port.
The 'Receive' LED of an RS-232 port is on (green) if data is received
through this port.

5

Analog Inputs (Volt)

The LEDs indicate the detector signal (voltage level) that is currently
applied to the analog input. Indication is in volt according to the
logarithmic scale on the right.

6

Digital I/O

The 'Input' LED is on (green) if the related signal line is connected to
digital ground.
The 'Output' LED is on (red) if the related potential-free relay contact
is closed.
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2.4 Rear Panel
1

5

2

3

6

4

7

Fig. 2: Rear panel connectors

No.

Description

1

Analog connectors (Analog Inputs)
The UCI-100 has eight analog inputs; the UCI-50 provides analog inputs on Ch.1
and Ch. 2.
In addition to the analog input, each analog connector provides a digital input
and a digital output (→ page 8).

2

Digital Inputs connector
The digital inputs are also distributed among the analog connectors (→ page 8).

3

LAN port (Ethernet)

4

USB port (Universal Serial Bus)

5

RS-232 ports (4 ports)

6

BCD input connector (16 BCD inputs)

7

Power socket
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2.4.1 Analog Connectors
In addition to the analog input, each analog connector (→ Fig. 2; no. 1) provides a digital
input (→ section 2.4.2) and a digital output (→ section 2.4.3). For information and tips
about the pin assignment, see page 51.
The UCI-100 has eight analog inputs; the UCI-50 provides analog inputs on Ch.1 and Ch. 2.
2.4.2 Digital Inputs
The digital inputs are distributed among the analog connectors (→ Fig. 2; no. 1), but are
also grouped in one separate connector (→ Fig. 2; no. 2).
The digital inputs allow the time-resolved acquisition of binary events. In this way, they
can be used to inform Chromeleon about external events, such as the injection of a sample.
TTL signal levels are processed.
For information and tips about the pin assignment, see page 52.
2.4.3 Digital Outputs
The digital inputs are distributed among the analog connectors (→ page Fig. 2, no. 1). The
relay outputs allow potential-free switching of external signals, and thus they can be used
transmit control signals to other devices. As these outputs are potential-free relay contacts,
they do not depend on specific signal levels. However, the maximum capacity of the
contacts has to be considered (→ Technical Information, page 47).
2.4.4 USB and LAN Ports
Data transmission between the UCI and Chromeleon is by using the integrated USB
interface or LAN interface and the appropriate connection cable from the accessories kit
(→ page 49). To ensure trouble-free operation, use only the cables described in section 7
(→ page 49).
For information about how to connect the UCI to the Chromeleon server OC by using a
USB connection, see page 14. For information about using a LAN connection, see page 16.
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2.4.5 RS-232 Ports
The four RS-232 ports allow simultaneous control of up to four modules of a
chromatography timebase. For information about the pin assignment, see page 53.
Tip:

The RS-232 ports do not support control of Gilson instruments that are
equipped with an GSIOC/RS-232 adapter, model 605. Connect these
instruments to the multi-serial (8-fold) PCI interface board (Equinox 8RS2332 Multi-COM board, part no. 5906.2095) of the computer.

2.4.6 BCD Inputs
The BCD inputs of the UCI allow autosamplers that can be controlled via binary code to
communicate to Chromeleon the position of the vial from which the injection was
performed. The BCD inputs are 16 digital inputs that can process TTL signals.
Communication is via an appropriate flat-ribbon cable. For information and tips about the pin
assignment, see page 54.
2.4.7 Power Receptacle
To connect the UCI to the main power supply, use the primary clocked power unit ('wide
range') and an appropriate power cord. No adjustment is required to adapt the line voltage
to local voltage requirements.
Warning:

Never use a power supply unit other than the power supply unit
provided for the device.
Do not use multiple sockets or extension cords. Using defective
multiple sockets or extension cords may cause personal injury or
damage to the device.

Avertissement: Utilisez uniquement le bloc d’alimentation électrique externe
spécifique à l’instrument.
N'utilisez pas des blocs multiprise ou des câbles prolongateurs. Cela
pourrait entraîner des blessures corporelles ou endommager
l'instrument.
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2.5 Operation with Chromeleon
The UCI is controlled by Chromeleon. All software details in this manual refer to
Chromeleon 6.80. For information about how to set up the UCI in Chromeleon, see
section 3.3.5 (→ page 28).
If you want to operate the UCI with Chromeleon 7, refer to the following documents for
information about how to perform the related processes in Chromeleon 7 (all documents are
included in the Chromeleon 7 shipment):
•

Chromeleon 7 Help—provides extensive information and comprehensive reference
material for all aspects of the software.

•

Quick Start Guide—describes the main elements of the user interface and guides you
step-by-step through the most important workflows.

•

Reference Card—provides a concise overview of the most important workflows.

•

Installation Guide—provides basic information about module installation and
configuration. For specific information about a certain module, refer to the Chromeleon 7
Help.

Please also note that Chromeleon 7 terminology is different from the terminology used in
Chromeleon 6.80. For details, refer to the 'Glossary - Chromeleon 7,' which is available in the
Documents folder of your Chromeleon 7 installation.
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3 Installation
3.1 Facility Requirements
The installation site must meet the following requirements:
•

Make sure that the power unit and power cord of the device can be easily reached and
that the device can be disconnected from the power line at all times.

•

Make sure that the installation site meets the power and environmental specifications
listed in the Technical Information section (→ page 47).

•

Install the UCI in the laboratory on a stable and level surface that is free of vibrations.

•

Make sure that the surface is resistant to solvents.

•

Avoid locations with extreme changes in temperature.

•

Avoid direct sunlight and drafts.

•

Do not expose the UCI to any corrosive, alkaline, or water vapors.

•

Allow sufficient clearance behind and to the sides of the UCI for ventilation.
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3.2 Unpacking
All electrical and mechanical components of the UCI are carefully tested before the
instrument is shipped from the factory. After unpacking, inspect the UCI for any signs of
mechanical damage that may have occurred during transit.
Tips: Immediately report any shipping damage to both, the incoming carrier and
Thermo Fisher Scientific. Shipping insurance will compensate for the damage
only if reported immediately.
Keep the original shipping container and packing material. They will provide
excellent protection for the UCI in case of future transit. Shipping the unit in
any other packaging automatically voids the product warranty.
1.

Place the shipping container on the floor and remove any accessories.

2.

Grasp the module by the sides. Slowly and carefully, pull the module out of the
shipping container and place it on a stable surface.
Important: To prevent the UCI from falling, grasp the UCI by the sides, and
then lift the UCI together with the foam spacers out of the shipping
container. Do not lift the UCI by the foam spacers.
Important: Afin d'empêcher l'instrument de tomber, saisissez-la par les côtés.
Ne soulevez l'instrument à l’aide du matériau d'emballage ou par la
porte du panneau avant.

3.

Remove the foam spacers, and then remove the polythene packaging.

4.

Before connecting the UCI to the power source, wait approximately four hours to
allow the instrument to come to room temperature and to allow any condensation that
might have occurred during shipping to evaporate. After four hours, check the UCI; if
condensation still exists, allow the UCI to continue to warm up (without connecting it
to the power source) until the condensation is completely gone.
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3.3 Connecting and Setting Up the UCI in Chromeleon
3.3.1 Connecting the UCI to the Chromeleon Server PC
The UCI is controlled by the Chromeleon Chromatography Management System.
Thermo Fisher Scientific recommends connecting the UCI to the Chromeleon server PC by
using a USB connection (→ page 14). If a USB connection cannot be used (for example,
Windows® NT 4.0 does not support USB), establish a network connection (LAN) for the
communication between the UCI and the data system (→ page 16). However, in this case,
observe the recommendations for network operation (→ page 27).
After connecting the UCI to the Chromeleon server PC, install and configure the UCI in
Chromeleon (→ page 28).
3.3.2 Connecting the UCI to External Devices
Two signal cables are included in the UCI shipment. Each cable can be used to send one
analog signal and one digital signal to the UCI and also to connect one relay contact to an
external device. To do so, plug the 6-pin connector of the signal cable into one of the
analog inputs ports on the rear panel.
Observe the wire labels when connecting the wires to the desired components. To avoid
errors in measuring, connect the ground wire to the corresponding detector connector.
Additional signal cables are available on request:
Signal cable

Part No.

Mini-DIN, 6-pin, cable length: 5 m

6000.1004 (two cables are included in the UCI shipment)

Mini-DIN, 6-pin, cable length: 10 m

6911.0005

As a result of the cable length, the signal quality may be slightly affected when a 10 m
signal cable is used.
Use the cable labeling set from in the accessories kit to label the signal cables as required.
To connect devices (for example, a pump) to the RS-232 ports, use common 9-pin
interface cables.
Tip:

If the device to be connected is data terminal equipment (DTE), for example, a
P580 pump, a null-modem cable is required.

When using the Digital Input and BCD Input connections, refer to pages 52 and 54 for
information and tips about the pin assignments.
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3.3.3 USB Installation
Tip:

Verify that Chromeleon is installed on the computer before you connect the
UCI to the USB port on the Chromeleon computer. Only then, the USB driver
for the UCI is loaded automatically and the Windows® operating system can
detect the UCI when the UCI is powered up.

Use the USB cable from the UCI accessories kit (→ page 49) to connect the USB port on
the rear of UCI to the USB port on the Chromeleon server PC.
Keep in mind that the USB standard limits the USB cable length to 5 meters. Each USB
device can be separated from the PC or next USB hub by no more than 5 meters. A special
USB extension cable (part no. 6000.1005) is available if a longer connection is required. Up
to five extension cables may be connected in series. However, for system reasons, the overall
connection length must not exceed 30 m.
1.

Turn on the computer power, if it is not already on.

2.

Under Windows Vista® (Windows® XP, Windows® 7, or Windows® Server 2008), log
on as a
•
•

3.

Local administrator if the computer is a local computer.
User with local computer administrator privileges if the computer is a network
computer.

Open the Chromeleon Server Monitor program by double-clicking the Chromeleon
Server Monitor icon

on the Windows taskbar.

If the Server Monitor icon is not on the taskbar, click Start on the taskbar, point to
Programs (or All Programs, depending on the operating system), point to Chromeleon,
and then click Server Monitor.
4.

Click Start to start the server.

5.

Click Close to close the Server Monitor window. The Server Monitor icon
appears on the taskbar.
(Clicking the Quit Monitor button quits (exits) the Server Monitor program, but does
not stop the server. To stop the server, click Stop.)

6.

Use the power unit and power cord shipped with the UCI to connect the instrument to
a grounded power source.

7.

Windows Vista, Windows 7, and Windows Server 2008
will automatically detect the new UCI and perform the USB installation.
If Windows fails to detect the UCI and launches a wizard instead, this indicates that you
connected the UCI to the computer and turned on the power for the first time before you
installed Chromeleon.
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To resolve the problem:
a) Click Cancel to exit the wizard.
b) Disconnect the UCI from the power source.
c) Install Chromeleon.
d) Reconnect the UCI to the power source. Windows will now detect the UCI and install
the USB software for the UCI automatically.
Windows XP
will automatically detect the new UCI and launch the Found New Hardware Wizard,
which guides you through the USB installation. Select the following options:
a) If asked whether Windows can connect to Windows Update to search for software,
select No, not this time.
b) Accept the default option (Install the software automatically) and click Next>.
c) Click Finish when the wizard reports that the software for the UCI has been
installed.
If Windows fails to detect the UCI and a message box asks for a USB configuration file
(cmwdmusb.inf), this indicates that you connected the UCI to the computer and turned on
the power for the first time before you installed Chromeleon. To resolve the problem:
a)
b)
c)
d)
8.

Click Cancel in the Windows message box.
Disconnect the UCI from the power source.
Install Chromeleon.
Reconnect the UCI to the power source. Windows will now automatically detect the
UCI and launch the Found New Hardware Wizard.

Set up the UCI in Chromeleon (→ page 28).
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3.3.4 LAN Installation
Tip:

Use the LAN connection only for Windows NT 4.0. For any other operating
system, Thermo Fisher Scientific recommends using a USB connection. When
using a LAN connection, observe the recommendations for network operation
(→ page 27).

Use the power unit and power cord shipped with the UCI to connect the instrument to a
grounded power source.
Use the LAN cable from the UCI accessories kit (→ page 49) to connect the LAN port on
the rear of UCI to the LAN port on the Chromeleon server PC.
To ensure robust communication between the UCI and the Chromeleon server through a LAN
connection, Thermo Fisher Scientific recommends using an instrument LAN connection
between the UCI and the Chromeleon server PC as an instrument LAN is independent of the
office LAN. This type of connection requires that you install a separate 10Mbit network
interface card (NIC) in the Chromeleon server PC and assign unique IP addresses to all
connected devices. For information about how the separate network interface card is installed
in the Chromeleon server PC, refer to page 18.
If the computer already contains a second network interface card for operating other Summit
HPLC devices, the UCI can be connected to this card. For information about how to connect
the UCI using an instrument LAN under Windows NT4, see page 17.
After the LAN connection has been installed as described, follow the steps on page 28 an the
following pages to setup the UCI in Chromeleon.
Tip:

Thermo Fisher Scientific cannot guarantee reliable communication when
operating the UCI on an office LAN because the load of the office LAN is a
decisive factor. Overload of the office LAN may result in timeouts and loss of
data and thus, disturb automatic operation of Chromeleon.
Therefore, the UCI should not be operated on an office LAN.
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3.3.4.1 Connecting the UCI through an Instrument LAN (Windows NT4)
If the Chromeleon server PC is running Windows NT4, the UCI can be connected to the
server PC only by using a LAN connection.
If you want to connect only a single UCI but no other instrument, you can connect the server
PC and the UCI by using a 'crossover' cable, which is a special network cable with crossedover data lines. These data lines are usually marked by colors (red, yellow) to distinguish the
crossover cable from standard network cables. In this case, the structure of the instrument
LAN is as follows (peer-to-peer connection):

Crossover cable
Server PC with 2 network interface cards

Fig. 3: Peer-to-Peer connection

If you want to connect several TCP/IP-enabled Summit HPLC devices to the server PC,
you must use a hub (10 Mbit) for the connection to the instrument LAN. In this case,
standard network cables must be used instead of a crossover cable. One standard network
cable, part no. 6906.2038, is provided in the accessories kit.)

Standard network cables

Server PC with 2 network interface cards

More Summit devices
if required

Fig. 4: Hub connection (10 Mbit hub)
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3.3.4.2 Separate Network Interface Card
A network connection that is independent of the office LAN is called an instrument LAN.
This kind of connection between the UCI and Chromeleon requires the installation of a
separate network interface card (NIC; called adapter in the operating system) in the server PC.
1.

Follow the installation instructions of the card manufacturer to install the card as
network interface card (Start → Settings → Control Panel → Network → Adapters
→ Add).

Fig. 5: Installing the separate network interface card

2.

Click the Bindings tab and configure the network adapter for the instrument LAN
(here: [2] 3Com Fast EtherLink XL NIC (3C905B-TX)). First, click the arrow next of
the Show Bindings for box and select all protocols on the list to verify that the
TCP/IP protocol is installed. Install the TCP/IP protocol if it is not yet installed:

Fig. 6: Show bindings for all protocols
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3.

Afterward, select all adapters in the Show Bindings for box. In the protocol window,
disable all protocols for the instrument LAN card except the TCP/IP protocol:

Fig. 7: Show bindings for all adapters

4.

As the TCP/IP protocol is used for the instrument LAN, an IP address and a subnet
mask are required for the separate network adapter. The dialog box for entering the IP
address and the subnet mask is opened automatically during installation.
(You can reopen the dialog box later if you need to change the IP address and the subnet
mask. Click Start → Settings → Control Panel → Network → Protocols. Right-click the
TCP/IP protocol and click Properties on the menu.

Fig. 8: Assigning the IP address and subnet mask
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In the Adapter field, select the network adapter for the instrument LAN and click
Specify an IP address.
Observe the following:
• Do not change the settings for the office LAN network interface card.
• For the adapter for the instrument LAN, disable all other network protocols and
services (see further up in this section).
5.

Assign a fixed IP address to the adapter for the instrument LAN.
First, identify the IP address that is used for the office LAN on your computer. To do so,
open a DOS command prompt by clicking Start → Programs → Command Prompt
and enter ipconfig /all. Differentiate between the two following cases:
Case A: Already used IP address ≠ 192.168.60.xxx
Case B: Already used IP address = 192.168.60.xxx
Note:
The subnet mask determines which part of the IP address describes the network and
which part defines the individual devices connected to the network. Independent LANs
have different network addresses. Based on the subnet mask 255.255.255.0 in the
example, the term '192.168.60' describes the network, while xxx defines the individual
modules in the network.
Case A:
Select the address from the range indicated below and enter the subnet mask specified
below:
IP address:
Subnet mask:

192.168.60.xxx (xxx can be any number between 1 and 254)
255.255.255.0

Do not enter a gateway address; no gateway is available for the instrument LAN and the
above addresses cannot be routed. Communication between the UCI and the Chromeleon
server is always direct.
Also observe the information in the Applies to both, case A and case B section on
page 21.
Case B:
If the range 192.168.60.xxx is already used for the office LAN, use a different network
range for the instrument LAN, for example, use 192.168.61.
Important: In this case, make sure that the addresses assigned to the individual Summit
HPLC modules also start with 192.168.61. Contact your system administrator for
information about the appropriate value for your individual configuration.
Do not enter a gateway address; no gateway is available for the instrument LAN and the
above addresses cannot be routed. Communication between the UCI and the Chromeleon
server is always direct.
Also observe the information in the Applies to both, case A and case B section on
page 21.
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Applies to both, case A and case B:
It may happen that the UCI that you want to control by the separate network adapter
already has an IP address and subnet mask assigned. In this case, when selecting the IP
address of the network adapter of the server PC, be sure that only the last digit differs
from the IP address of the UCI. Otherwise, it will not be possible to address the
connected Summit HPLC devices.
Example for a valid configuration for case A:
UCI:

IP address
192.168.60.51
Subnet mask 255.255.255.0

Server:

IP address
192.168.60.50
Subnet mask 255.255.255.0

Example for a valid configuration for case B:
UCI:

IP address
192.168.61.51
Subnet mask 255.255.255.0

Server:

IP address
192.168.61.50
Subnet mask 255.255.255.0

Observe the following:
• Every device on the same network must have a unique IP address. Selecting
duplicate IP addresses may cause conflicts on the network.
• Do not use 0 or 255 as the last numbers in IP addresses.
6.

To check and verify the selected settings, enter the following commands at the DOS
level (Start → Programs → Command Prompt):
ipconfig /all

This command lists the configuration of all network adapters. If this command returns
also the IP address and subnet mask of the newly installed 10 Mbit network adapter, the
adapter has been configured successfully.
route print

This command checks whether you can address the UCI with the network adapter used
for the instrument LAN. If the selected network (here, for example, 192.168.60.0)
appears under Target and if the related subnet mask appears under Net mask, the new
network adapter is configured correctly.
ping 192.168.60.51

This command checks the connection to the UCI that has the IP address 192.168.60.51. If
the UCI will reply to the ping command, the installation is correct.
7.

To operate the UCI on the instrument LAN, assign an IP address and subnet mask
(→ section 3.3.4.3).

8.

Set up the UCI in Chromeleon (→ page 28).
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3.3.4.3 Assigning IP Properties (CmIPUtil)
To operate the UCI on an instrument LAN, an IP address, and subnet mask must be
assigned, by using the CM IP Utility program.
Observe the following:
•

Parameters can be programmed and changed only if no data is being transferred between
the UCI and the Chromeleon server. To stop the Chromeleon server, click Start →
Programs → Chromeleon → Server Monitor.

•

Configuration is possible only if the computer on which CmIPUtil is running is
connected to the same subnet as is the UCI for which you want to assign IP properties.

•

With CM IP Utility, only UCI modules with firmware version 2.0 or later (LAN support)
can be configured.
Tip:

If you want to use the network capabilities of a UCI with a firmware
version < 2.0, first download the most recent firmware to the module
(→ page 45). This is possible only by using the USB connection.
Afterward, configure the module as described further down in this section.

•

Make sure that the TCP/IP protocol is available on the computer.

1.

Copy the CmIPUtil program from the Chromeleon CD into a separate directory on
your computer if it is not yet already there.

2.

Double-click Setup.exe and follow the installation instructions on the screen.

3.

Open the program by clicking Start → Programs → Chromeleon → IP Utility →
CmIPUtil.
The Module Information window of the dialog box lists all modules that are active on
the network, together with their IP address, serial number (S/N), server name (that is the
name or IP address of that server with which data are currently exchanged), gateway
address, subnet mask, and Ethernet address. The IP address for modules that have not yet
been configured is 0.0.0.0 or 255.255.255.255 (→ Fig. 9, page 23).
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Fig. 9: Assigning the IP properties (CmIPUtil)

4.

Enter the IP address and the subnet mask for the modules to be configured. The values
depend on the settings for the adapter for the instrument LAN (→ page 21).

5.

Select the module to be configured by the serial number.

6.

In the Available IP Addresses window, select the IP address to be assigned to the
UCI. If it is not listed, click Add/Remove and enter the desired address.

7.

Enter the required subnet mask. Verify that this is the same subnet mask is used for the
Chromeleon server PC.
In this case, when selecting the IP address of the network adapter of the server PC, be
sure that only the last digit differs from the IP address of the UCI. Otherwise, it will not
be possible to address the connected Summit HPLC devices.
Example for a valid configuration:
UCI:
IP address
192.168.60.51
Subnet mask 255.255.255.0
Server:

IP address
192.168.60.50
Subnet mask 255.255.255.0

To configure several TCP/IP-enabled Summit HPLC devices, make sure that every
device has its own IP address. For the example, the following entries would be possible:
2. TCP/IP enabled device:

IP address
192.168.60.52
Subnet mask 255.255.255.0

3. TCP/IP enabled device:

IP address
192.168.60.53
Subnet mask 255.255.255.0
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Observe the following:
•

Every device on the same network must have a unique IP address. Selecting
duplicate IP addresses may cause conflicts on the network.

•

Do not use 0 or 255 as the last numbers in IP addresses.

8.

The Gateway Address input box must not be empty, although no gateway is available
for the instrument LAN. Therefore, enter the IP address of the device to be configured
also in this input box to prevent a gateway from being used.

9.

When the necessary entries are complete, click Assign to assign to the module. After
about one second, the module will appear with new parameters in the Module
Information window.

10. Click Query to check the settings.
11. Click Exit to close the program.
Tip:

Verify that a unique IP address has been assigned to all Summit HPLC devices
that are connected to the Chromeleon server PC.

For more information, see the CmIPUTil Help.
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3.3.4.4 Network Operation
3.3.4.4.1 Network Traffic

The TCP/IP protocol, which is known from the Internet, is used for the LAN communication
between the UCI and Chromeleon. The network traffic, which depends on the amount of raw
data to be transported (number of active analog channels), is as follows:

LAN traffic in kBytes/sec

LAN traffic (RS232 Ports not active)
35
30
25
20
15

TCP packets Host -> UCI-100

10

TCP packets UCI-100 -> Host

5
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1
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8

7

8

Number of active analog channels

Fig. 10: LAN traffic without active RS-232 ports

LAN traffic in kBytes/sec

LAN traffic (all RS232 Ports active)
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Number of active analog channels

Fig. 11: LAN traffic wit active RS-232 ports
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3.3.4.4.2 Puffer Time

Operating the UCI by using a LAN connection in case of high network traffic may lead to
transmission failures. That is why the raw data are temporarily stored in the UCI module.
However, the available memory capacity depends on the amount of raw data to be transported
(→ Fig. 12) and thus, is limited.
40
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35
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Fig. 12: Max. buffer time in case of network overload

Tip:

If the network failure exceeds the buffer time described above, analog data
may be lost.
If you notice these effects, Thermo Fisher Scientific recommends establishing
a USB connection between the UCI and the Chromeleon server. As the USB
bus is capable of performing real-time operations, overloading effects will not
occur. If a USB connection cannot be established, take appropriate measures to
avoid interruptions of the network communication between the Chromeleon
server and the UCI (→ Recommendations for Network Operation, page 27).
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3.3.4.4.3 Recommendations for Network Operation

Unlike USB connections, Ethernet LAN connections have limited real-time capabilities. Data
transmission can occur only when no other connected user is using the network. To take full
advantage of the real-time capabilities of the UCI, select the instrument LAN connection
(→ page 17). This ensures that other network users do not delay the server communication.
If the UCI module is connected to Chromeleon by a LAN connection, Thermo Fisher
Scientific advises against using the digital inputs for remote inject synchronization. This is
because the timing of LAN communication varies, depending on the current LAN traffic.
If the UCI module is connected to Chromeleon by using a USB connection, all remote inputs
are polled after 0.1 seconds and can be used without restrictions.
Tip:

Thermo Fisher Scientific cannot guarantee reliable communication when
operating the UCI on an office LAN because the load of the office LAN is a
decisive factor. Overload of the office LAN may result in timeouts and loss of
data and thus, disturb automatic operation of Chromeleon. Therefore, the UCI
should not be operated on an office LAN.
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3.3.5 Setting Up the UCI in Chromeleon
All software details in this manual refer to Chromeleon 6.80. If you want to operate the
UCI with Chromeleon 7, note the information on page 10.
3.3.5.1 Installing the UCI
After the USB software for the NCS has been installed (→ page 14) or the LAN connection
has been established (→ page 16), install and configure the UCI in Chromeleon:
1.

Start the Chromeleon Server Monitor and the Chromeleon server if they are not yet
running.
a) Open the Chromeleon Server Monitor program by double-clicking the Chromeleon
Server Monitor icon
on the Windows taskbar. (If the Server Monitor icon is not
on the taskbar, click Start on the taskbar, point to Programs (or All Programs,
depending on the operating system), point to Chromeleon, and then click Server
Monitor.)
b) Click Start to start the server.
c) Click Close to close the Server Monitor window. The Server Monitor icon
appears on the taskbar. (Clicking the Quit Monitor button quits (exits) the Server
Monitor program, but does not stop the server. To stop the server, click Stop.)

2.

Start the Chromeleon Server Configuration program by clicking Start on the taskbar.
Point to Programs (or All Programs, depending on the operating system), point to
Chromeleon, and then click Server Configuration.

3.

Click the plus sign next to the server name to display the items underneath.

4.

Right-click Sharable Devices in the timebase and click Add Sharable Device on the
menu.

5.

In the list box, select Dionex UCI-1000 Interface (or UCI-50 Interface) and click
OK to confirm the selection.

6.

The configuration pages for the UCI are opened. On each page, verify that the settings
are correct and select additional settings if needed. For a description of the pages, see
section 3.3.5.2 (→ page 29).

7.

On the File menu, click Save Installation and then close the Server Configuration
program.
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3.3.5.2 Configuring the UCI
Verify that the default settings are correct and change them if needed. If you want to change
the settings at a later date, double-click the UCI to reopen the configuration pages.
Tip:

Changing the settings for a specific application in the Commands dialog box,
in a program file (PGM), or on a control panel will not change the default
settings on the configuration pages.

For additional information about a page, click Help.
General page
The General page shows the general instrument parameters.

Fig. 13: General page

•

Demo Mode
Select the Demo Mode check box if you want to read and display a demo chromatogram
instead of real data. To specify the demo chromatogram, select the Demo tab
(→ page 31).

•

Firmware Download
Click this button to transfer the firmware version available for the UCI in Chromeleon to
the module. (The button appears dimmed if the Demo Mode is enabled.)
The UCI is shipped with the most recent firmware version. If a firmware update is ever
required, follow the steps in section 5.2 (→ page 45).
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•

Module Address
Click Browse to select the module address of the UCI. (The button appears dimmed if
the Demo Mode is enabled.)

Fig. 14: Device list

The following information is displayed:
• The Address column lists all UCI modules that are available via Ethernet (TCP/IP)
together with their IP address and/or all UCI modules that are available via USB
with the prefix 'USB' and their serial number.
•

The Server Name column indicates whether a UCI is already connected to a
Chromeleon server PC. If a UCI is available for connection to the server, the entry is
0.0.0.0 or the column is empty.

•

The S/N column shows the serial number of the UCI.

•

The Ethernet column shows the Ethernet address of the UCI.

Double-click the UCI that you want to use. The address is automatically entered in the
Module Address box. Clicking OK establishes the connection to the module. This
process may take some seconds. As soon as the connection has been established
successfully, the related Connect message including the firmware version is displayed in
the audit trail.
Tip:

•

A UCI module can be connected to only one chromatography server.
However, its interfaces and signals can be shared among several timebases
(Shared Device; → page 34).

LAN Timeout
You can specify a LAN Timeout between 1 and 30 seconds. For LAN connections with
high network traffic, this setting allows prolonging the timeout for the communication
between the Chromeleon server and devices that are connected to the RS-232 port of the
UCI.
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Demo Page
On the Demo tab, specify the demo chromatogram.

Fig. 15: Demo page

If the Demo Mode check box is selected on the General tab page, the UCI does not use
previously recorded signal course, but simulates data acquisition and reads out and
displays a demo chromatogram instead of real data. For this purpose, the UCI driver
includes a 'Software Peak Generator'. Use this page to specify the signal properties for the
demo chromatogram.
No entries are required on this page if you want to use the default chromatogram. Otherwise,
select the 12 peaks in succession and specify the following:
•
•
•
•

In the Retention Time box, enter the preferred retention time in minutes.
In the Left Width@5% box, enter the left peak width at 5% of the peak height.
In the Right Width@5% box, enter the right peak width at 5% of the peak height.
In the Height box, enter the peak height.
The demo chromatogram can include up to 12 peaks. To exclude a peak from the
chromatogram, set the peak height to zero. To create overlapping peaks, use the left and
right peak width settings.

To determine the signal noise for the demo chromatogram, enter the preferred value in the
Noise box.
For more information, see the Chromeleon Help.
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3.3.5.3 Adding more than one UCI to the Server Configuration
If the server configuration already includes one UCI and you want to add another UCI
module, a message appears indicating that the UCI driver has already been installed:

Fig. 16: Message that a UCI driver is already loaded

Click Yes to load another instance. Continue the installation as described in section 3.3.5.1
(→ page 28).
When the installation is complete, the UCI appears in the Server Configuration program
together with the related instance number. One Chromeleon server can control up to four
UCI modules.

Fig. 17: Server configuration including several UCI modules

For more information, see the Chromeleon Help.
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3.3.5.4 Setting Up the Analog Inputs
If you want to use the analog inputs of the UCI in Chromeleon, the timebase must include
either the Integrator Driver or the device driver for a third-party analog detector. The
steps below refer to the installation of the Integrator Driver; however, they are similar for
other third-party device drivers:
1.

In the Server Configuration program, select the timebase to which you want to add
the Integrator Driver or create a new timebase (on the Edit menu, click Add
Timebase).

2.

Open the Add device to timebase dialog box. To do so, click Add Device on the Edit
menu or right-click the timebase and click Add Device on the menu.

3.

On the Manufacturers list, click Generic and on the Devices list, click Integrator
Driver.

4.

On the Signals page, select the signals that you want to use by the check box. If a
check box is cleared, the signal will not be available in Chromeleon.

5.

To configure the signals to be used, select a signal and click Change.

6.

The Signal Configuration dialog box provides the following options:

7.

Option

Description

Signal Name

Enter a unique signal name for future identification of the signal.
Avoid changing previously assigned names. Changing names may result in
conflicts with existing PGM Files and panel controls.
Any raw data recorded for the related signal are directly linked to the signal
name.

AD Port

Select the channel to be used for signal recording with the UCI.
Make sure that the selected channel corresponds to the actual pin assignment.
If more than one UCI module is installed in the Server Configuration program,
keep in mind that the AD ports of the different modules can be distinguished
only by the instance numbers of the UCI.

Unit

Enter the signal unit (for example, mV or mAU).

Factor

The Factor is the conversion factor between mV and the signal unit of the
connected detector.
If the signal value at the detector output is, for example, 1000 mV, and if the
signal shall be represented in mAU instead, enter mAU in the Unit box and 1
in the Factor box.

Offset [mV]

Each A/D-channel can receive a signal offset that is added to the actual signal.
This can be used to balance pressure or temperature readings. For example, if a
thermometer supplies a voltage of 1 V at 0 °C, this can be compensated by
entering an offset value of -1000 mV.

Confirm the entries by clicking Ok. The Integrator Driver is installed and the
selected signals are available in Chromeleon.

For more information, see the Chromeleon Help.
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3.3.5.5 Setting Up the Digital Inputs, BCD Inputs, and Relay Outputs
The available relays and digital inputs are Shared Devices, that is, they need not be used
on the same timebase. If you want to use the relays and digital inputs of the UCI in
Chromeleon, installation of Shared Relays and Inputs driver is required.
1.

In the Server Configuration program, select the timebase to which you want to add
the Shared Relays and Inputs driver or create a new timebase (on the Edit menu, click
Add Timebase).

2.

Open the Add device to timebase dialog box. To do so, click Add Device on the Edit
menu or right-click the timebase and click Add Device on the menu.

3.

On the Manufacturers list, click Generic and on the Devices list, click Shared
Relays and Inputs. The configuration pages for the driver are opened.

4.

Relays / TTL Outputs page
Click Add and then, in the Port Assignment dialog box, assign the preferred ports to the
relays and TTL outputs.
In the Name box, enter a unique name for future identification of the signal. In the Port
box, select the UCI port that you want to use from the drop-down list (UCI100_Relay1
through UCI100_Relay8). The relay numbers on the list correspond to the channel
numbers (Ch. 1 to Ch. 8) on the rear panel of the UCI.

5.

TTL Inputs page
Click Add and then, in the Port Assignment dialog box, assign the preferred ports to
TTL inputs.
In the Name box, enter a unique name for future identification of the TTL input. In the
Port box, select the UCI port that you want to use on the drop-down list (UCI100_Input1
through UCI100_Input8, UCI100_BCD-1A, UCI100_BCD-1B). The input numbers on
the list correspond to the ports according to the tables on pages 52 and 54.

6.

Confirm the entries by clicking Ok. The Shared Relays and Inputs driver is installed
and the selected signals are available in Chromeleon.
Tips: If more than one UCI module is installed in the Server Configuration
program, keep in mind that the relays and TTL inputs of the different
modules can be distinguished only by the instance numbers of the UCI.
With controlled chromatographic systems, the autosampler communicates
the time of injection to Chromeleon via an RS-232 cable. This is not
possible for non-controlled injection units. In this case, the Remote Inject
driver is required to communicate the time of injection from the
autosampler or a manual injection unit to Chromeleon and thus, to
synchronize the start of data acquisition with the injection.
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7.

Install the Remote Inject driver if it is not yet installed. In the Chromeleon Server
Configuration program, right-click the timebase in which you want to install the
driver and select Add Device on the menu.

8.

On the Manufacturers list, click Generic and on the Devices list, click Remote
Inject. The configuration pages for the driver are opened.

9.

General page
Device Name displays the name used to identify the external injection unit in the
installation environment. To use existing control panels, accept the default name. If you
enter a different name, you may have to re-link the controls on the control panels and edit
the name in the program files.
The Inject Port list shows all external remote start devices that have not yet been
selected as inject port. Select the inject port (= preferred UCI port) that sends the signal.
When executing a program, Chromeleon executes the Inject command and continues
with the program only after the signal from the inject port has been received.

10. Confirm the entries by clicking Ok. The Remote Inject driver is installed and
available in Chromeleon.
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3.3.5.6 Assigning the RS232-Ports
To control a device via an RS-232 port of the UCI, the related communication port must be
assigned in the configuration of the device that you want to control.
1. In the Server Configuration program, right-click the device and click Add Properties
on the menu.
2. On the General page, select the preferred port on the Port list. The port numbers on the
list correspond to the port numbering on the rear panel of the UCI.
Tips: Thermo Fisher Scientific recommends using the USB connection to
control devices via the RS-232 ports (→ Puffer Time, page 26).
If more than one UCI module is installed in the Server Configuration
program, keep in mind that the RS-232 ports of the different modules can
be distinguished only by the instance numbers of the UCI.
3.3.5.7 Commands and Properties in Chromeleon
After the installation, the components appear together with their commands and properties
in Chromeleon, in the Commands dialog box. They are listed under the name specified
during the installation. To open the Commands dialog box, click Command on the
Control menu. (The Control menu is visible only when a control panel is open.)
The commands and properties that are available in the dialog box may vary, depending on the
Chromeleon version, configuration, and the display filter level (Normal, Advanced, or
Expert). Change the display filter level if necessary. For more information, see the
Chromeleon Help.
The following commands/properties are available for the analog inputs:
Command/Property

Description

Delta

The signal slope, useful for triggers (difference between the current
value and the value one second ago)

Retention

The retention time of the signal (range 0.00 to 10000000.00 min)

Signal

The current signal value (range -10000.00 to 10000.00 mV). Click the +
sign next to Signal to display the items underneath: Value (current
value), UpperLimit, and LowerLimit. The system aborts the sample
batch if the value is outside the upper and lower limits.

AcqOff

Stops data acquisition.

AcqOn

Starts data acquisition.

MaxAutoStep

Maximum step rate for Auto Step mode (default: 5.1 seconds).
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Command/Property

Description

Step

Rate at which data points are recorded (range 0.01 to 5.20 sec.)
AUTO sets the best step rate dynamically (recommended).

Average

Available options are On and Off. Select On to integrate the sampled
values over the step interval. Select Off to record only the last measured
value of every step.

The following commands/properties are available for the relays:
Command/Property

Description

State

Indicates (or sets) the state of the relay. Available options: On and Off.

Duration

If set, the relay will toggle after the specified time (range: 0.00 to
59999.90 sec.)

On

Opens the relay.

Off

Closes the relay.

The following commands/properties are available for the TTL inputs:
Command/Property

Description

State

Indicates (or sets) the state of the relay. Available options: On and Off.

For more information, see the Chromeleon Help.
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4 Troubleshooting
Messages that appear in the Chromeleon Audit Trail (see table further down in this section)
help you to identify and eliminate the source problems that may occur during the operation
of the UCI. Observe the following:
•

Error messages will vary slightly, depending on the connection type specified for the UCI
in the Server Configuration program (USB or LAN). Thus, the error messages below
may also read UCI-100 @ USB-00-E0-EF-DE-XX-XX (for XX-XX see the rear panel of
the UCI), UCI-100 @ + IP address (for example, UCI-100 @ 192.168.50.1) or UCI100@ + serial number (for example, UCI-100@USB-01610103) instead of just UCI-100.
This applies in the same way to the UCI-50.

•

If the server configuration has been changed in any way, messages referring to the
previous configuration may continue to appear for up to 30 seconds after the change.
These messages can be ignored. Therefore, always note the device name (UCI-100 @...
or UCI-50@…) referenced in the message..

•

Before loading down the firmware, disconnect the Chromeleon server from any
instruments that are controlled via the RS-232 ports of the UCI. The connection must be
interrupted during the firmware download. Terminating the connection during the
download may result in various error messages in the Audit Trail.

If you are unable to eliminate a problem following the instructions given here, contact
Thermo Fisher Scientific Service for Dionex HPLC Products.
The following table lists the most important messages along with possible causes and
suggests remedial actions.
Message

Probable Cause

Remedial action

No response from UCI for 5
seconds. The network may be
broken or overloaded.

The network load is too high.

Reduce the network load. The
network connection between the
Chromeleon server and the UCI
might be inappropriate
(→ page 27). Contact your
network administrator.

No response from UCI for 30
seconds. Device disconnected.

The connection between the UCI
and the Chromeleon server PC
may be interrupted.

Check the network connection.

The power supply to the UCI may
be interrupted.

Check the connection to the power
supply of the UCI.
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Message

Probable Cause

Remedial action

No response from UCI for 30
seconds. Device disconnected.
(Cont'd)

The network load is too high.

Reduce the network load. The
network connection between the
Chromeleon server PC and the
UCI might be inappropriate
(→ page 27). Contact your
network administrator.

No response from UCI-100 @
USB-00-E0-EF-DE-XX-XX
for 5 seconds. The network
may be broken or overloaded.

The type of connection between
the UCI and the Chromeleon
server PC was changed from a
LAN connection to a USB
connection.

This message can be ignored.

Error opening UCI Connection refused.

The UCI is connected to another
Chromeleon server PC.

Verify that the correct UCI is
selected. Terminate the
communication between the UCI
and the other Chromeleon server
PC.

The existing connection is not yet
cleared completely.

Wait for 30 seconds and repeat the
procedure.

The subnet mask and gateway
address of the UCI are configured
incorrectly.

Check and change the parameter
settings in CmIPUtil if necessary
(→ page 22).

A gateway may maintain an
unintended connection to a UCI
when the Chromeleon server PC is
stopped in a non-controlled way
(for example, due to a powerfailure).

Restart the UCI.

The Chromeleon server PC failed
to connect to the UCI.

Verify that the UCI is powered-up
and that the network connection is
working.
Note the name of the UCI to
which the message refers. The
error message might refer to a UCI
that is no longer part of the current
server configuration. But the
Chromeleon server PC still tries to
connect to this module. Check and
change the module address as
necessary and retry.

The network connection was
interrupted during firmware
download.

Check the network connection.

Error opening UCI Connection timed out.
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Message

Probable Cause

Remedial action

Error opening UCI Connection timed out.
(Cont'd)

The power supply to the UCI was
interrupted during firmware
download.

Check the connection to the power
supply of the UCI. Restart the UCI
and repeat the firmware download.
If the message appears again,
contact Service.

UCI - Connection reset by peer.

The network load is too high.

Reduce the network load
(→ page 27).

The power supply to the UCI has
been interrupted for a short period.

Check the connection to the power
supply of the UCI.

Network problems: The
connection to the UCI cannot be
established.

Check network settings for the
UCI and network interface card.
The network connection between
the Chromeleon server PC and the
UCI might be inappropriate
(→ page 27). Contact your
network administrator.

The network load is too high.

Reduce the network load
(→ page 27).

The connection between the UCI
and the Chromeleon server is
interrupted for a longer period.

Check the network connection.

The device couldn't be queried
for its firmware version.
The new version is x.xx
Download anyway?

When the firmware download is
started, there is no connection
between the Chromeleon server
and the UCI specified in the
Server Configuration program
under Sharable Device >
Properties > Module Address.
Thus, the firmware version that is
installed in the UCI cannot be
established.

If you want to download the
firmware without checking the
current firmware version of the
UCI, confirm the message. As
soon as the connection to the UCI
specified in the Server
Configuration program has been
established, the firmware is
download, replacing the firmware
version installed in the UCI by the
version indicated in the message.
If you want to check the current
firmware version before the
download, make sure that the
connection to the UCI is
established before the download is
started (→ page 45).

UCI. The amplifiers are not
working in the specified gain
range.
The deviation can still be
compensated but maintenance
is recommended.

The electronics of the specified
UCI works near the limits
specified for operation.

You may continue working.
However, you should contact
Service.

UCI. The amplifiers are not
working in the specified gain
range.

The electronics of the specified
UCI does not work within the
limits specified for operation.

Contact Service.

UCI - Host not found.
UCI - Permission denied.
UCI - Network is unreachable.
UCI - No route to host.
UCI - Lost XXX data packets.
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Message

Probable Cause

Remedial action

UCI - Error erasing flash
memory.
—or—
UCI - Error programming flash
memory
—or—
UCI - Error finishing
download.

The connection between the UCI
and the Chromeleon server PC is
interrupted during the firmware
download.
The power supply to the UCI may
be interrupted.

Check the USB or LAN
connection and also the
connection to the power supply of
the UCI. Restart the UCI and
repeat the firmware download. If
the message appears again, contact
Service.

UCI - Firmware download
failed.

The firmware download failed
several times. The message
appears together with other
messages describing the cause (for
example, UCI - Error erasing flash
memory, - Error programming
flash memory, - Error finishing
download).

Perform the remedial actions for
the messages that appear in the
Audit Trail before this message.

UCI-100 @ USB-00-E0-EFDE-XX-XX - Device not found
on the USB.

The USB connection between the
UCI and the Chromeleon server
may be interrupted.

Check the USB connection.

The power supply to the UCI may
be interrupted.

Check the connection to the power
supply of the UCI.

The USB connection between the
UCI and the Chromeleon server
may be interrupted.

Check the USB connection.

The power supply to the UCI may
be interrupted.

Check the connection to the power
supply of the UCI.

Error issuing control request to
UCI-100 @ USB-00-E0-EFDE-XX-XX – The selected
configuration does not exist. A
firmware download may be
necessary.

The firmware download has not
completed correctly due to
termination of the USB
connection.

Check the USB connection.
Start or repeat the firmware
download.
Check the connection to the power
supply of the UCI.

Error issuing control request to
UCI

The Chromeleon server cannot
connect to the UCI indicated in the
message.

Check the USB or LAN
connection and also the
connection to the power supply of
the UCI.
Remove the UCI indicated in the
message from the configuration.
Else, select a different UCI on the
list of available UCI modules in
the Server Configuration program.

Error opening UCI-100 @
USB-00-E0-EF-DE-XX-XX –
The System cannot find the file
specified.
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Message

Probable Cause

Remedial action

Error reading from UCI-100 @
USB-00-E0-EF-DE-XX-XX
Data error (cyclic redundancy
check)

Communication error between the
UCI and the Chromeleon server
PC.

Check the USB connection. The
connection to the next hub must
not exceed 5 m. The overall
connection length, including the
hub connections must not exceed
30 m.
Replace any defective USB cable
or hub.

Error reading from UCI-100 @
USB-00-E0-EF-DE-XX-XX

The connection between the UCI
and the Chromeleon server may be
interrupted.

Check the USB connection.

The power supply to the UCI may
be interrupted.

Check the connection to the power
supply of the UCI.
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5 Maintenance and Service
5.1 General Information
No maintenance is required on part of the user. Service procedures must be performed by
Thermo Fisher Scientific service personnel.
Before returning any UCI for repair, contact Thermo Fisher Scientific Service for Dionex
HPLC Products. An RMA (Return Material Authorization) number is required to track
your instrument. Always use the original shipping container. Shipping the instrument in
anything else than the original packaging voids the warranty. For more information, see the
warranty statement in the terms of sale.

5.2 Updating the UCI Firmware
The UCI is shipped with the most recent firmware version. The UCI firmware is also
included in Chromeleon. To check which firmware version is included in Chromeleon,
locate the IQReport.log file in the IQ folder of your Chromeleon installation and, in the
file, search for UCI100.hex (or UCI50.hex).
Whenever a new firmware version is released for the UCI, the new version will be
provided with the next Chromeleon Service Release and described in the related release
notes.
The new firmware will not be downloaded automatically to the UCI when you install a
Chromeleon Service Release.
Observe the following:
•

Before loading down the firmware, disconnect the Chromeleon server from any
instruments that are controlled via the RS-232 ports of the UCI. The connection must be
interrupted during the firmware download. Terminating the connection during the
download may result in various error messages in the Audit Trail (→ page 39).

•

To ensure that the download is successful, make sure that the communication between
the UCI and Chromeleon is not interrupted during the download and that you do not
disconnect the UCI from the power supply.

•

If the UCI has a firmware version < 2.0 installed, the download is possible only by using
the USB connection. To use the LAN capabilities of the UCI after the download,
configure the module for network operation in CmIPUtil (→ page 22).
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To update the firmware in the UCI, follow these steps:
1.

Verify that the Chromeleon server is in running idle mode, that is, all processes on the
Chromeleon server PC and in Chromeleon have been stopped.

2.

Start the Server Configuration program (→ page 28).

3.

Right-click the UCI in the timebase and click Properties on the menu.

4.

On the General page, click Firmware Download (→ page 29). A message displays the
firmware version that is currently installed in the UCI and the version that will be
downloaded from Chromeleon.
Tip:

5.

If the UCI comes with a newer firmware than the version included in
Chromeleon, do not downgrade the firmware. Older firmware may be
incompatible with new hardware revisions.

Click Yes to start the download. (Click No to cancel the action.)

The download may take several minutes. The download is complete when Download
completed successfully appears in the Messages Server window in the Chromeleon Server
Configuration program. The message appears also in the Chromeleon Audit Trail.
If the download is not successful, the related messages appear in the Audit Trail. In this case,
turn the UCI off and on again. Repeat the download as described above. If the download fails
again, contact Thermo Fisher Scientific Service for Dionex HPLC Products.
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6 Technical Information
Analog inputs:
Number

UCI-100: 8 (independent); UCI-50: 2 (independent)

Max. input voltage

± 10 Volt (bipolar)

Input impedance (analog)

> 107 Ω (static)

Dynamic resolution

25 bit

Number of input ranges

8 (with autoranging)

Resolution

< ± 1 µV

Voltage noise

< 2 µV, peak to peak

Offset (absolute)

< ± 10 µV

Voltage drift

≤ 20 ppm/°C (on each range)

Sampling rate

100 Hz per channel

Linearity (0-5000 mV)

Correlation coefficient > 99.9999%, RSD < 0.15%

Digital Inputs:
Number

8 (TTL compatible)

Input voltage (digital)

0–5 Volts

Relay outputs:
Number

8

Functionality

Default open

Switching capacity

100V, 0.5A, 10W max.; potential free

RS-232 ports:
Number

4

Baud rate

Up to 9600 baud (all channels)
Up to 19200 baud (two channels)
Up to 38400 baud (one channels)

Handshake

RTS/CTS hardware or Xon/Xoff software

PC interfaces:

USB version 1.1; Ethernet LAN: 10BASET (RJ45 connector)

Miscellaneous
Environmental conditions:

Range of use: Indoor use
Temperature: 10 °C to 35 °C (50 to 95 °C)
Air humidity: 40 to 85% relative humidity, non-condensing
Overvoltage category: II
Pollution degree: 2

Weight

1.95 kg

Dimensions (H x W x D)

71 x 285 x 220 mm

Technical information: September 2013. All technical specifications are subject to change
without notice.
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7 Accessories and Spare Parts
Accessories, consumables, and spare parts are always maintained at the latest technical
standard. Therefore, part numbers are subject to alteration. However, updated parts will
always be compatible with the parts they replace.

7.1 Standard Accessories
The following accessories are shipped with the instrument (the list is subject to change
without notice). The part number always refers to the packing unit. Unless otherwise
stated, the packing unit is 1 unit. For more information, contact the Thermo Fisher
Scientific sales organization for Dionex HPLC Products.
Description

Quantity
in the kit

Part No.

Signal cable (6-pin Mini-DIN, 5 m)

2

6000.1004

USB cable, 5 m, type A to type B

1

6911.0002

RS54 cable for Ethernet connection, 3 m

1

69062038

Power supply unit 12 V DC, 1,25A ('wide range')

1

1510.0003

Cable labeling set, 1-8 Dmax 4.7

1

5911.9011

7.2 Optional Accessories
Description

Part No.

Note

USB extension cable with
signal amplifier (5 m)

6000.1005

Up to five extension cables may be connected in series.
However, for system reasons, the overall connection
length must not exceed 30 m.

Signal cable, UCI (10 m)

6911.0005

As a result of the cable length, the signal quality may be
slightly affected when the 10 m signal cable is used.
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8 Pin Assignment
8.1 General Information
The following sections provide detailed information about the pin assignment of the
analog, digital, and BCD inputs as well as about the DC input and RS-232 ports. The USB
and LAN interfaces correspond to the respective standards.
Important:

To prevent damage to the UCI, observe the polarity (digital inputs)
and be sure that the input voltages not within the valid range.

Important:

L'inversion de polarité (entrées numériques) et des tensions d'entrée
en dehors du domaine de validité put endommager l'instrument.

8.2 Analog Inputs

Fig. 18: Analog input (6-pin connector, rear panel view)
Range
Analog LOW ↔ Analog HIGH

± 10 V
(The UCI-50 provides analog inputs on Ch. 1 and Ch. 2.)

Digital Input ↔ Digital GND

0 or +5 V

Digital Out (GND) ↔ Digital Output

Switching: 100V; switching current: 0.5 A limiting value
of mean on-state current: 1.0 A; switching capacity: 10
W/10 VA volume resistance: max. 0.15 Ohm

Tip:

If the UCI is connected to the Chromeleon server PC by a LAN connection, the
ground connection of the UCI is potential free (contrary to a USB connection).
With some detectors, this may affect the analog signal quality. To connect the
UCI ground to the detector ground, connect the (green) Digital GND wire of
the signal cable to the respective detector ground.

Operating Instructions

Page 51

Universal Chromatography Interfaces
UCI-50 and UCI-100

8.3 Digital Inputs

Fig. 19: Digital inputs (9-pin D-Sub female connector)
Pin

Tip:

Port

Signal Level

1

Input-1

TTL

2

Input-2

TTL

3

Input-3

TTL

4

Input-4

TTL

5

Input-5

TTL

6

Input-6

TTL

7

Input-7

TTL

8

Input-8

TTL

9

Ground

GND

Internal device resistors keep the digital input level at + 5 V (pull-up
resistance). Therefore, it is possible to use a contact closure relay, without an
additional voltage source. This closure has to be installed between GND and
the respective digital input. Once the relay is shut, the digital voltage is
grounded.
The relay is under a low current of about 50 µA. If the signal source is active,
that is, emitting voltage, verify the correct polarization of the digital input. The
ground of the signal source must be connected to the ground of the UCI. The
digital output of the signal source must be connected to the digital input of the
UCI.
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8.4 RS-232 Ports

Fig. 20: RS-232 port (9-pin D-sub connector)
Pin

Signal Name

1

DCD

2

RX

RS232

3

TX

RS232

4

DTR

RS232

5

GND

GND

6

DSR

7

RTS

RS232

Hardware handshake

8

CTS

RS232

Hardware handshake

9

RI

Operating Instructions
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Remarks
Not used

active (+10V, Ri=2,7kΩ)
Not used

Not used
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8.5 BCD Inputs (Sample Position Recording)

Fig. 21: BCD inputs (25-pin D-sub female connector)

If the marked wire of a flat ribbon is connected to pin no. 1 of the female connector, the
wires of the flat ribbon are numbered as follows:
Pin

Page 54

Wire

Port

Signal Level

1

1

BCD-1A

TTL

2

3

BCD-1B

TTL

3

5

BCD-1C

TTL

4

7

BCD-1D

TTL

5

9

GND

GND

6

11

BCD-2A

TTL

7

13

BCD-2B

TTL

8

15

BCD-2C

TTL

9

17

BCD-2D

TTL

10

19

GND

GND

11

21

GND

GND

12

23

GND

GND

13

25

GND

GND

14

2

BCD-3A

TTL

15

4

BCD-3B

TTL

16

6

BCD-3C

TTL

17

8

BCD-3D

TTL

18

10

GND

GND

19

12

BCD-4A

TTL

20

14

BCD-4B

TTL

21

16

BCD-4C

TTL

22

18

BCD-4D

TTL

23

20

GND

GND

24

22

GND

GND

25

24

GND

GND
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Tip:

Internal device resistors keep the digital input level at + 5 V (pull-up
resistance). Therefore, it is possible to use a contact closure relay, without an
additional voltage source. This closure has to be installed between GND and
the respective digital input. Once the relay is shut, the digital voltage is
grounded.
The relay is under a low current of about 50 µA. If the signal source is active,
that is, emitting voltage, verify the correct polarization of the digital input. The
ground of the signal source must be connected to the ground of the UCI. The
digital output of the signal source must be connected to the digital input of the
UCI.

8.6 Power Receptacle
9 to 18 Volt DC

Fig. 22: DC input
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